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1. Introduction

The USB to RS-232 Adapter is a low-cost, high-performance cable. It operates as a bridge and provides easy
connectivity between a USB port and a serial port. The serial port can be configured as an asynchronous UART
interface and can support flow control. It is designed to be compliant with a variety of applications, including COM
port replication, and is ideally suited for many peripherals like POS terminals, Barcode readers, Printers, Gaming
consoles, Medical devices, Modem, Serial Mouse, Industrial meters, PDA, GPS, etc.

System Requirements

@ Windows OS : 98SE / ME / 2000/ XP / Vista/ 7/ 8/ 8.1/ 10; Windows Server 2003 / 2008 / 2008R2 / 2012 /
2012R2 or higher

@ WIinCEOS:V4.2~V7.0

@ Mac 0S:8.6/9.x/10.x

@ Linux OS: Kernel 1.5.0 or higher

@ The system is equipped with USB Host Controller

Features

@ Fully Compliant with USB Specification 1.1 and 2.0

@ Supports the asynchronous serial interfaces.

@ Supports data transfer rate up to 230 kbps

@ Supports remote wake-up and power-on-reset

@  Supports £15kV HBM ESD protection

@ Compatible with Windows 98SE / ME / 2000/ XP / Vista/ 7/ 8/ 8.1/ 10; Win CE, Windows server 2003 /
2008 / 2008R2 / 2012 / 2012R2; Mac OS 8.6/ 9.x / 10.x, Linux 1.5.0 or higher

Specification

Model No. UTS-232X45 RJ-45 Pin Assignment
Chip FTDI Pin 1 VCC
Data Transfer Rate Up to 230kbps Pin 2 RX
USB Specification USB 1.1/2.0 compliant Pin 3 CTS
Connector Upstream USB Type A Male Pin 4 RTS
Device 8P8C RJ-45 Male Pin5 TX
Cable Length 2m Pin 6 GND
Power Mode Bus Powered Pin 7 NC
Housing Plastic Pin 8 NC
1 2 34567 8 8 7 6543 2 1 Pin Signal
1 vCC
2 RX
3 CTS
4 RTS
5 X
6 GND
e ke 1N
8 NC



2. Windows OS Installation Guide

Driver can be installed through Windows Update automatically (Internet connection needed)

The FTDI drivers that have passed the WHQL tests are available for download using Windows Update.
OS requirements: Windows 7/8/8.1/10 or later.

Please go below ways for easy installation.
1. You may plug the device into host computer. And then it will pop up ‘Installing device driver software’ from the

taskbar of the screen. (Fig. 1) Click and connect to the Windows Update.

2. It will check your computer OS and download the applicable driver at the Windows Update automatically.

:B Installing device driver software * *

Click here for status,

Fig. 1

3. The program goes ‘Searching Windows Update’ from ‘Driver Software Installation’. (Fig. 2)

Installing device driver software

Generic USE Hub o Use
LUSB =-= Serial i_)Searching Windows Update... I

Obtaining device driver seftware from Windows Update might take a while.
Skip obtaining driver software from Windows Update

Fig. 2

4. When the applicable driver is detected, it will run ‘Installing device driver software’. (Fig. 3)

-
_'_! Driver Software Installation

Installing device driver softwagg

USB <-> Serial | (@] Searching preconfigured driver folders... |

Fig. 3




5. Then it shows ‘USB Serial Port (COMS) installed’. Click ‘Close’ and go next step. (Fig. 4)

-
"_! Driver Software Installation

Your device is ready to use
USE Serial Converter +f Ready to use
USE Serial Port (COME) JReadyto use

Fig. 4

6. Check ‘Device Manager’ of Control Panel from the computer OS and there shows USB Serial Port (COMS8) under
‘Ports (COM & LPT)’; the other one shows USB Serial Converter under ‘Universal Serial Bus controllers’. (Fig. 5)
Congratulation! You have finished installing the USB to Serial device successfully.

r
= Device Manager - =0
Eile Action View Help

&= |5 E| HFE @ E %S

- Network adapters -
- Hl Portable Devices
473 Ports (COM &LLPT)

b D Processors
b -% Sound, video and game controllers
| » {8 System devices

a- ﬂ Uniwversal Serial Bus controllers

----- E Generic USE Huk

| | E Generic USB Hub

..... § Generic USB Hub

..... @ USB Root Hub
----- i USE Root Hub
..... ¥ USE Reot Hub
..... @ USB Root Hub
..... ¥ USB Reot Hub
----- i USE Root Hub
..... USE Root Hub

m

T UsDh
: @ USE Serial Converter
HE ")

[ Y S 1 W S Ve YRR 1 ;) P |

Fig. 5

NOTE: It may occur when driver is not installed successfully, please check below steps.

1. There is busy on access databank of Microsoft's Support link. Please try again or install driver of CD-ROM
provided.

2. Check your internet if it is failed to access Microsoft's Support link.

3. Check your computer configuration if it is disabled on Windows Update wizard.

-
Device driver software was not successfully installed

Please consult with your device manufficturer for assistance getting this devid%installed,
USB <-> Serial € No driver found

What can I do if my device did not install properly?

Close




3. Driver Installation thru the FTDI Driver Package
Driver can be installed through the FTDI driver package of the CD-ROM provided.

3.1. Double click ‘Setup_v2.12.00 WHQL Certified For Windows OS_x86.x64.exe’

-

E

Linux(1.5.0) Mac 0% 8 9 IMac 05X 109 Windows Windows
and above(2.3) 98ME(1.09.06) 2000(2.06.00)

m

l l
Windows CE Windows RT XP, 2003 Vistafp0 | Setup v2.12.00
42-3.2 6.0 Mo 08,7,8,8.1,200BR | WHQL Certified
bile 2,2012R2(2.180 For Windows
2003,20035E,5... o) 05_x86.x84.exe

3.2. It will pop up ‘FTDI CDM Drivers’ from the screen. Click ‘Extract’ and go next step.

' i

FTDI CDM Drivers

Click 'Extract’ to unpack version 2. 12,00 of FTDI's Windows
driver package and launch the installer.

www ftdichip com

Cancel




3.3. Extracting Files

' B

Extracting Files
FreeExtractor is extracting the compressed files in this archive.

Flease wait while the files in this archive are extracted.

Extracting Static/i386 /ftd2wc.lib ...

| | Cancel

3.4. Click ‘Next’ to continue.
- _
Device Driver Installation Wizard

Welcome to the Device Driver
Installation Wizard!

This wizard helps you install the software drivers that some
computers devices need in order to work.

To continue, click Nest.




3.5. Select ‘I accept this agreement’ and click ‘Next’.

Device Driver Installation Wiza

To continue, accept the following license agreement. To read the entire
= agreement, use the scroll bar or press the Page Down key.

IMPORTANT NOTICE: PLEASE READ CAREFULLY BEFORE -
INSTALLING THE RELEVANT SOFTWARE: |:|
This licence agreement (Licence)is a legal agreement between you
(Licensee or you) and Future Technology Devices Intemational Limited

of 2 Seaward Place, Centurion Business Parc, Glasgow G41 THH,

Scotland (UK Company Mumber 5C136640) (Licensor or we) for use of
driver software pravided by the Licensor(Software).

BY INSTALLING OR USING THIS SOFTWARE YOU AGREE TO THE -

(@ i accept this agreement [ Save fis l [ Erint
") | don't accept this agreement

3.6. The Device Driver Installation Wizard will detect your computer OS and install the applicable driver
automatically.

Device Driver Installation Wizard

The drivers are now installing...

“

N

L -

Please wait while the drivers install. This may take some time to complete.




3.7. While the Device Driver Installation Wizard is completing, click ‘Finish’ to exit.
Device Dnver Installation Wizard

Completing the Device Driver
Installation Wizard

The drivers were successfully installed on this computer.

You can now connect your device to this computer. f your device
came with instructions, please read them first.

Driver Name Status

s’ FTDI COM Driver Package - Bus/D2¥... Readyto use
s FTDI COM Driver Package - VCP Driv... Readyto use
4 I

[ Cancel

4. Driver Installation
Windows 98 Installation Guide

If a device of the same type has been installed on your machine before and the drivers that are about to be installed
are different from those installed already, the original drivers need to be uninstalled. Please refer to the uninstalling
instruction.

Download the latest available drivers from the FTDI website and unzip them to a location on your PC.

Connect the device to a spare USB port on your PC. This will launch the Windows Add New Hardware
Wizard. Windows may display a message reading "Building driver database" at this point which may take
a few minutes to pass. Click "Next" to proceed with the installation.

Add HNew Hardware Wizard I

Thiz wizard searches fol new drivers for

USE <-» Serial Cable

& device driver is a zoftware program that makes a
hardware device work.

< Bk Cancel



http://www.ftdichip.com/

Select "Search for the best driver for your device. (Recommended)." as shown below and then click "Next".

Add Mew Hardware Wizard

Whal do you want Windows to do?

% Bearch for the best diiver for pour device. |
{Recommended].

" Dizplay a list of all the drivers in a specfic
location, so vow can select the diver you want,

¢ Back I Mest » I Cancel |

Check the box next to "Specify a location" and uncheck all others as shown below. Click "Browse" and locate the
driver files. Once the files have been located, click "Next" to proceed with the installation.

Add Hew Hardware Wizard

‘Wincows will search for new drivers in its diver database
on your hard drive, and in any of the following selected
lozations. Click Mest to start the search.

[~ Foppy disk drives
[ CD-ROM dive
™ Microsoft Windows Update

W Specify a location:
D =]
Browse... |

< Back I Mest > I Cancel |




Windows may display a message reading "Building driver database" at this point which may take a few
minutes to pass. Once Windows has found the required files, click "Next" to install the device.

Add New Hardware Wizard

YWincows driver file zearch for the device:

IJSE Senal Corverter

Windows is now ready b install the best diver for this
device. Click Back to zelect a different driver, or click Mest
to continue.

Locaion of driver:

CAWTFDRI14FTDIBUS INF
=J

Cancel

If the driver being installed does not have Microsoft WHQL signature files (.CAT files), the wizard will request a
driver disk to attempt to find them. Click "OK" on the "Insert Disk" message box.

Inzert Disk |

Q Fleaze ingert the diz< labeled 'FTDI USE Drivers Disk', and then click OF.

The following window will appear to assist in locating the file. To proceed with the installation without the .CAT file,
click "Skip File".

10



Inzert Dizk E3 |

The file 'frdibuz.cat on FTDN USE Drivers k.
é‘ Dizsk cannot be found,

Cancel

Inzertt FTDI USE Drvers Digk in the zelected
drive; and click Ok

Skip File

Dietails...

Cooy files from:

PR Lk

CAER Dirivers _j Browse. ..

If the driver being installed is Microsoft WHQL certified, then the .CAT files will be located with the other
driver files and should be installed automatically.

Windows should then display a message indicating that the installation of the serial converter driver was
successful. The COM port emulation driver must now be installed. Click "Finish" to complete the
installation of the serial converter and proceed to the COM port emulation driver.

Add New Hardware Wizard

% USE Serial Converter

Windaws has finished instaling the software that yaur new
hardware device requires.

¢ Haok Cancel

Under Windows 98, the COM port emulation driver will be automatically installed from the same location as the
serial converter driver. However, if the driver is not WHQL certified as explained above for the serial converter driver,
the wizard will ask for the location of .CAT files. Click "OK" on the "Insert Disk" message box.

Insert Disk |

Q Flease insert the dis< labeled FTOI USE Drvers Disk’, and then click OF.

11



The following window will appear to assist in locating the file. To proceed with the installation without the .CAT file,
click "Skip File".

Inzert Dizk |
The file 'frdiport.catl an FTCH USE Drivers k.
g_l Dizk cannot be found.

Cancel
Inzert FTDI USE Drivers Digk in the selected
drive, and click 0K

Skip File

Dietails...

Cooy files from:

[EE

CAER Dirivers j Browse. ..

If the driver being installed is Microsoft WHQL certified, then the .CAT files will be located with the other driver files
and should be installed automatically.

Open the Device Manager (located in "Control Panel\System" then select the "'Device Manger" tab) and select
"View devices by type". The device appears as an additional COM port with the label "USB Serial Port".

Syztem Properties Ed |

General Device Manager | Hardware Profiles I Performance I

& \iew devices by ype £ Wiew devices by connection
#-#% Keyboard -]
&8 Madem
g taritars
Iﬂi'a Mouze
F-+_r Multil0 Controller
-EE Nebwork adapters
- Ports [COM & LPT)
;y" Communications Port [COM1]

. PCIECP/EPP Part [LPT1]
o PEI Serial Pait [COM2)

4]

B Sustemn devices
: IIniverzal Senial Buz contrallers

- USE Serial Port [COM

Univerzal Senial Buz contrallers

[<]

Properties | Refrezh | Remove | Print... |

Ik I [Canrel |

12



Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat this
installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or appropriate
versions from FTDI Web site www.ftdichip.com/Drivers/VCP.htm .

Uninstalling Instruction
To uninstall drivers, follow the instructions below:
Disconnect any devices that are attached to the PC.

Open the Add/Remove Programs utility located in "Control Panel\Add/Remove Programs". Select "FTDI
USB-Serial Converter Drivers" from the list of installed programs.

Add/Remove Programs Properties EE

Install/Uninstal | Windows Setup I Startup Digk I

T o nztall a new program from a Hoppy digk or CO-ROM
drive, click [nztal.
Lo,

Inistall...

If’ The fallowing zoftware can be automaticall removed by
L] Wirdows. Toremove aprogram or bo modily itz installed
components, select it from the list and click
Add/A emove.

Chinese [Traditional]l Language Supy
T LISE-toSenal Conwverter Drivers
etRight

[mztantCO DV -J
[ntermnet Explorer 828750

Japarnesze Languages Suppaort

Fermellriver

K.ep Drive 1.0
K.orean Language Suppart ;I

Add/Bemove... I

k. Cancel Al |

13
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Click the "Add/Remove" button. This will run the FTDI uninstaller program. Click "Continue" to run the uninstaller or
"Cancel" to exit.
FTDI Uninstaller ¥2.0

If your USB device iz connected, pleaze unplug it now.__

Presz Continue to unmnstall the dnivers, or Cancel to quit.

Continue |

When the uninstaller has finished removing the device from the system, the caption on the "Cancel" button will
change to "Finish". Click "Finish" to complete the process.

FTDI Uninstallzr v3.0 ]|

Uninstalling VID_0403%P1D_6001

Deleting reqistiy entnes.
Deleting files._.

Uninstall complete, presz Finizh to exit.

[EEtirne |

14



Troubleshooting

1. Windows 98 cannot find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in the INF
files for the driver. The VID and PID programmed into the device EEPROM may be found by using the USBView
utility from the FTDI website. These can then be checked against the VID and PID entries in the driver INF files. If
they do not match, that driver cannot be installed the VID and PID entries in the driver INF files. If they do not match,
that driver cannot be installed for that device without either re-programming the device EEPROM or modifying the
list of VID and PID numbers in the INF files. Please note that only your own company VID and PID or FTDI's VID
(0x0403) and FTDI PID issued for use by your company should be used in the EEPROM and INF/INI files.

2. Windows 98 forces a reboot after installing a device

This problem can occur if an application is accessing a file while the New Hardware Wizard is trying to copy it. This
usually occurs with the FTD2XX.DLL file. If installing a D2XX device, selecting not to restart the computer then
unplugging and re-plugging the device may allow the device to function properly without restarting. Restarting the
machine will allow the device to work correctly.

3. Driver installation fails and Windows 98 gives error code 10

Windows error code 10 indicates a hardware error or failed driver installation. This error may appear if a device has
insufficient power to operate correctly (e.g. plugged into a bus powered hub with other devices), or may indicate a
more serious hardware problem. Also, it may be indicative of USB root hub drivers being incorrectly installed. Please
refer to the example schematics on the FTDI website for standard device configurations. If the error persists,
please contact the FTDI support department.

4. Windows 98 complains about missing .CAT files

Files with the .cat extension are signature files issued by Microsoft that indicate a device driver is WHQL certified. If
a driver is not certified, there will be no .cat files available.

When installing drivers in Windows 98 or Windows ME, the user is prompted to locate the .cat files if the operating
system cannot find them. If the driver is not certified but you wish to install it anyway, the files may be skipped by
clicking the "Skip" button.

5. Windows 98 complains about missing ftccomms.vxd file

This can occur when the USB Composite driver has been installed if the user has not browsed to the location of the
driver files. If this message appears, do not skip it but browse to the driver file location. The wizard will then be able
to correctly install the device.

15
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Windows 2000 Installation Guide

If a device of the same type has been installed on your machine before and the drivers that are about to be
installed are different from those installed already, the original drivers need to be uninstalled. Please refer
to the uninstalling instruction.

Download the latest available drivers from the FTDI web site and unzip them to a location on your PC.

Connect the device to a spare USB port on your PC. Once the composite driver has been installed the
Found New Hardware Wizard will launch. Click "Next" to proceed with the installation.

Found New Hardware Wizard

N Welcome to the Found New
. Hardware Wizard

Thiz wizard helps you install 2 deviee driver for 2
hardware device.

To continue, click Mext.

< Biach l Mewut » I Cancel

Select "Search for a suitable driver for my device (recommended)” as shown
below and then click "Next".

Found Mew Hardware Wizard i

Install Hardware Device Drivers 2
£ devica diver iz a zoftware program that enables a hardware device to work with
an operating system,

Thig wizard will complete the installation for this device;

@ LISE << Serial Cable

& dewice driver is a software program that makes a hardware device work. Windows
needs diver files for vour new device. To locate driver files and complete the
installation click Mest,

Wwhat da pau want the wizard to do?
% Search for a suitable driver for my device [recommendad)

£ Dizplay a list of the known drivers for this device 2o that | can choose a specific
diiver

< Back I Mext » I Cancel

16
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Check the box next to "Specify a location" and uncheck all others as shown below. Clicking "Next" displays a
dialog box for you to enter to the location of the drivers.

Found New Hardware Wizard i

Locate Driver Files
Where do you want “Windows to search for diver files?

Search far driver files for the following hardware device:

@ LISE <= Serial Cable

The wizard searches for suitable drivers in itz driver database on pour computer and in
any of the following optional search locatiors that you specify.

To starkthe search, click Mest. If you are searching on a floppy disk or CO-ROM drive,
inzert the floppy digk or CD before clicking Hest,

Optional search locations:
I Floppy disk drives
[~ CD-ROM drives
¥ Specify a locatian
™ Microzoft Windows Update

¢ Back I MHest > I Cahcel |

Found New Hardware Wizard I x|
Inzert the manufacturer's installation disk inta the drive 0k |
g zelected, and then click OF.

Cancel |

Copy manufacturer's files from;

C:ACDM 2,00.00 | | Browss.. |

17



Click "Browse" to display an open file dialog box.

Laok ir: | =3 COM 2.00.00 |« ® ek mE-

. FTDIELS.INF
FTDIPCRT.INF

@

2

by Documents

File name: IFTDIBUS.INF j Open I
j Cancel |

Files of type: ISetup Infarmation (%

Locate the folder containing the latest drivers downloaded from the FTDI web site above and click "Open", then
click "OK". The PC auto selects the correct INF file, in this case FTDIBUS.INF.

Once Windows found the required driver .INF file, please click "Next" to proceed.

Found New Hardware Wizard

Driver Filez Search Results
The wizard haz finizhed searching for driver files for your hardware device.

The wizard found a driver for the following device:

@ LISE <= Serial Cable

windows found a driver for this device. To fistall the driver ‘Windows found, click Next.

Lg o hedrn 2,00, 00 kdibuz, ink

< Back I Mext » I Cancel

18
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Windows should then display a message indicating that the installation was successful. Click "Finish" to complete
the installation for the serial converter driver for this port of the device. The COM port emulation driver must be
installed after this has completed.

Found Mew Hardware Wizard

Completing the Found New
? Hardware Wizard

_\> IJSBE Senial Converter

YWindows has finizhed installing the zoftware for this device.

To cloze thiz wizard, click Finigh.

¢ Back I Finizh I [Eancel

By examining the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and click
"Device Manger...") and viewing by connection ("View > Devices by connection"), the device appears as a "USB
Serial Converter" with an additional COM port with the label "USB Serial Port".

=
r.ﬂ.ctlon Wiew ||h¢|%-|@||@ |

Lﬂ--‘l___], Intel{R) 82801EE LPC Interface Controller - 2400 ;!
=3 Intel(R) 52501E6 PCI Bridge - 244E

; R Inkel(R) PROJ100 YE Metwork Connecsion

] : B Realtek RTLS139/5310:x Family Fast Ethernet MIC
‘lg:!, IntellR) 82301E6 aMBus Controller - 2407

LH'?-\_, IntellR) 32301EE Ultra ATA Storage Controllers

L+‘_|'-|?_4 IntellR) G2301ER Ultra ATA Starage Contrallers
[+-82 Intel(R) §2801EE USE Universal Host Controller - 2402
L+‘_| Intel{R) 82801EE USE Universal Host Cantroller - 2404
L:‘ InteI(R) 82801EB USE Universal Host Controller - 2407

D E&P 1138 Serial Corverker
'}y’ USE Serial F‘Drt [ZOM3)

- Controller - 24DE
rﬂ ) 1rteliR) B2B55G Graphu:s Cantraller
o[l TntelfR) §2865GYPEVP Processor ko IO Controller - 2570
' Ej— Realtek AC'S7 Audio

. !EI, System board

|- Audio Codecs L2

Legacy Audio Drivers

|~ Legacy Yideo Capture Devices

B | ngical Dsk Manager

|- Media Control Devices _'_i

19



Please note:
1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat this
installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or appropriate
versions from FTDI Web site www.ftdichip.com/Drivers/VCP.htm .

20
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Uninstalling Instruction

When uninstalling devices from Windows 2000, it should always be done through the Add/Remove Programs utility
as this uses the FTDI driver uninstaller program to remove files and registry entries to leave a clean system. Other
methods may leave fragments of the driver that may interfere with future installations.

Disconnect any devices that are attached to the PC.

Open the Add/Remove Programs utility located in "Control Pane\Add/Remove
Programs ".Select "FTDI USB Serial Converter Drivers" from the list of installed programs.

% Add/Remove Programs ;lgl il
Sork I:uy:l Mame - |

Click the "Change/Remove" button. This will run the FTDI uninstaller program. Click "Continue” to run the uninstaller
or "Cancel" to exit.

FTDI Uninstaller I x|

IT your USEB device is connected, please unplug it now ...

Press Continue to uninstall the drivers, or Cancel to quit.

When the uninstaller has finished removing the device from the system, the caption on the "Cancel" button will
change to "Finish". Click "Finish" to complete the process.

FTDI Uninstaller I x|

Uninstalling VID_04034P1D_6010

Deleting registry entries ...
Deleting files ...

Press Finish to exit.

21



Troubleshooting
1. Windows 2000 cannot find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in the INF
files for the driver. The VID and PID programmed into

the device EEPROM may be found by using the USBView utility from the FTDI web site. These can then be checked
against the VID and PID entries in the driver INF files. If they do not match, that driver cannot be installed for that
device without either re-programming the device EEPROM or modifying the list of VID and PID numbers in the INF
files. Please note that only your own company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use by
your company should be used in the EEPROM and INF/INI files.

2. Windows 2000 forces a reboot after installing a device

This problem can occur if an application is accessing a file while the New Hardware Wizard is trying to copy it. This
usually occurs with the FTD2XX.DLL file. Selecting

not to restart the computer then unplugging and re-plugging the device may allow the device to function properly
without restarting. Restarting the machine will allow the device to work correctly.

3. Driver installation fails and Windows 2000 gives error code 10

Windows error code 10 indicates a hardware error or failed driver installation. This

error may appear if a device has insufficient power to operate correctly (e.g. plugged into a bus powered hub with
other devices), or may indicate a more serious hardware problem. Also, it may be indicative of USB root hub drivers
being incorrectly installed. Please refer to the example schematics on the FTDI web site for standard device
configurations.
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Windows CE Installation Guide

Download the latest available drivers for the required processor model from the FTDI website and unzip them, the
critical files in the driver package are:

ftdi_ser.dll - the VCP driver file
FTDIPORT.inf - user changeable file to allow devices with custom VID and PID combinations to be installed
Copy all of the unzipped files to the WWindows directory on the PDA.

If the PDA requires a host adaptor (e.g. USB host cable, presentation pack or Compact Flash host card), make
sure that it is connected and installed before proceeding.

Connect the FTDI device to a host USB port on the PDA. This will provide a dialog box to direct Windows CE to the
driver files.

Type the full name of the VCP driver file into the dialog box as shown below. If the file name is incorrect, the driver
will not be found and the device will not function.

| Entar the namea of tha davice
driver for this device. For
information, see the device
manufacturer's documentation.

| | Ftollser.d |

| 0K | | Cancel |

1231]2[3[4]5(6]7]8]9]0]- |=
Tab[q[w[e[r[t[y[uli]o]p|l
CAPla[s|d]|f]a]n|jlk[1];]"

|
—

Ghift| z [% [ €]V |b[n]m],].]/]
ctilaa] * [\] [4[t]<]>
=l

The device installation is now complete. The installation may be verified using the test program available form the
Utilities page of the FTDI website.
Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat this
installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or appropriate
versions from FTDI Web site www.ftdichip.com/Drivers/VCP.htm .
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Troubleshooting

1. "Unidentified USB Device" dialog is not displayed when device is
connected for the first time

If the "Unidentified USB Device" dialog is not displayed when the device is connected for the first time, it is likely
that the PDA does not have a USB host capability or that the host is not installed correctly.

Many PDAs require some form of adaptor (USB host cable, presentation pack or Compact Flash USB host card)
to provide the USB host capability that FTDI devices require.

2. "Error installing USB driver ftdi_d2xx.dll" message

The following installation error may be displayed for a number of reasons:

# | Unidentified USB D o 4% 10:36

(9 sunday, June 01, 2003
F=] Tap here to sek owner infarmation

B Mo upcoming appaintments

New Tools Accounts .ﬂ % E|‘

The driver name has been misspelt - The ".dllI" file extension may be required for some platforms - The required
driver files are not in the \Windows directory - The driver file is in the wrong binary format
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3. "Error installing USB driver ftdi_ser.dll" message

The following installation error may be displayed for a number of reasons:

¥ Unidentified USB D o % 12:17

(¥ sunday, June 01, 2003
F=] Tap here to sek owner information

=] Noupcoming appointmerts

= : .
= | Error instaling USE driver

New Tools Accounts E % E|"‘

The driver name has been miss pelt - The ".dIlI" file extension may be required for some platforms - The required
driver files are not in the \\Windows directory - The driver file is in the wrong binary format

4. "Unidentified USB Device" appears each time the driver name is entered

This error can be caused when the VID and PID listed in the INF file does not match the VID and PID combination
programmed into the device. It can also be caused if the INF file has not been copied to the \\Windows directory.

£ | unidentified USB D ¢ #x 10:38

Sunday, June 01, 2003

entified USB Device = | Inidentified USB Device

= |Inid

2 Enter the name of the davice
driver for this device. For

[¥| information, see the device

| manufacturer's docurmentation,

B Enter the name of the device
driver for this device. For

[w| information, see the device

| manufacturer's documentation,

1231]2[3[4[5]6]7]8[9]0]-
Tabiq[wle[r[t[y[u]i]o]p
caP[a[s[a[f[a[n[j[k[1];
Shift| 2 Yib(nim|,|.|/
claa]” T

> | €
—

L 12
-
— ™
]
-
—
>
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One way to check this is to use the Registry editor that comes with Embedded Visual C++ (or a suitable registry
editor on the Windows CE device itself); you may check for the registry settings (Tools > Remote Registry Editor).
With ActiveSync running, connect to your device then look at the registry setting
KEY_LOCAL_MACHINE\Drivers\USB\LoadClients\

S
Ragetry Edt Vs Coonadtion Help

) o = ) O 3 2 e [
% =) My Conguter ] [ Harme | Dats
= E3 POCKET PC 2003 Dt A f k)
<0 PREY _CLASEES ponT
%1 | HEEY_CURPENT LISER
-0 HEEY_LCAL_MACHINE
*{] Comm

Cyshs not et

= I UsE
-] ChandDiregrd

(2] FiD0_DEvECE_sbio

EL ] LnaediChents

i Pl

[PORRET P 2000 DevicejHRET_LOCAL_HACHIMI Drrver slISE L oadChenks| LOZT_24552] =

In this case, the entry is 1027_24592, which corresponds to a VID of 0x0403 (1027) and a PID of 0x6010 (24592)
device. If this is not the device to be installed, the message will recur.

To solve the problem, the INF files must be edited to accommodate the required VID and PID. For the D2XX drivers,
edit the bold red entries in the following line in the ftd2xx.inf file:

[FtdiHw]
"FTDI Dual device"=FTDI,USB\&VID_0403&PID_6010

For the VCP drivers, edit the bold red entries in the following line in the FTDIPORT.inf:

[FtdiHw]
%VID_0403&PID_6010.DeviceDesc%=FtdiPort232, FTDIBUS\COMPORT&VID_0403&PID_6010
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5. Device can write but cannot read

If the hardware does not work correctly under Windows 2000 or Windows XP then the problem is most likely a
hardware issue. Windows CE is not very tolerant of noisy hardware, so even "good" designs for Windows 2000
and XP may experience problems with Windows CE.

Another issue that has arisen with Windows CE is that different host devices support different bulk transfer sizes.
One method to attempt to resolve this is to reduce In Transfer Size to 64. This is the smallest possible transfer size
and will have a severe effect on performance, but should resolve most other issues. Larger values may be tried to
improve performance.

If a USB host CF card is being used, it may help to set the Raton bit in the configuration settings.

6. Bytes missing or data corrupt

This can occur when a host driver fails to send vendor commands properly which can result in the device running at
a different Baud rate to the one intended. The Baud rate can be verified easily by transferring data from PDA/target
to HyperTerminal.

Some host device drivers have been seen to lose packets of data which would also cause this problem.

7. Driver isn't sending or receiving any data
Sending and receiving data can be tested with an application such as VCPTest. However, this will not highlight

problems due to incorrect Baud rates. To check for the wrong Baud rate being set, try to transfer data from the
PDA/target to and from HyperTerminal.
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Windows XP Installation Guide

1. Installing Via The Found New Hardware Wizard

If a device of the same type has been installed on your machine before and the drivers that are about to be installed
are different from those installed already, the original drivers need to be uninstalled. Please refer to the Uninstalling
instruction.

Download the latest available drivers from the FTDI web site and unzip them to a location on your PC.

If you are running Windows XP or Windows XP SP 1, temporarily disconnect your PC from the Internet. This can be
done by either removing the network cable from your PC or by disabling your network card by going to the "Control
Panel\Network and Dial Up Connections", right clicking on the appropriate connection and selecting "Disable" from
the menu. The connection can be re enabled after the installation is complete. This is hot necessary under Windows
XP SP 2 if configured to ask before connecting to Windows Update. Windows XP SP 2 can have the settings for
Windows Update changed through "Control Panel\System" then select the "Hardware" tab and click "Windows
Update".

Connect the device to a spare USB port on your PC. If there is no available Internet connection or Windows XP SP
2 is configured to ask before connecting to Windows Update, the screen shown in Figure 2.1 is displayed. Select
"No, not this time" from the options available and then click "Next" to proceed with the installation. If there is an
available Internet connection, Windows XP will silently connect to the Windows Update website and install any
suitable driver it finds for the device in preference to the driver manually selected.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

“Windows will search for current and updated software by
laoking an vour computer, on the hardware installation CD. or an
the Windows Update ‘Web site [with your pemizsion).

Online privacy infarmation

Can Windows connect to ‘Windows Update to gearch for
software?

(O Yes, this time anly
d every time | connect a device

o

Click Mext to continue.

[ Mext » ][ Cancel

Figure 2.1

Select "Install from a list or specific location (Advanced)" as shown in Figure 2.2 below and then click "Next".
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Select "Search for the best driver in these locations" and enter the file path in the combo box ("C:\CDM 2.02.04" in
Figure 2.3 below) or browse to it by clicking the browse button. Once the file path has been entered in the box, click
next to proceed.

Found New Hardware Wizard

Thiz wizard helps you install software for:

USE Serial Convarter

f"'j If your hardware came with an installation CD

\‘@ or floppy disk. insert it now.

‘what do you want the wizard to da?

() Install the software automatically (R ecommended)

Click Next to continue.

[ < Back “ Mext > ][ Cancel

Figure 2.2

Found New Hardware Wizard
Please choose your search and installation oplions.

(%) Search for the best driver in these locations.

Use the check boxes below ta limit or expand the default search, which includes local
pathz and removable media. The best diver found will be installed.

[ Search removable media (floppy, CO-ROM...)
Include this location in the search:

|C:ACOM 2.02.04 ~| | Browse |

(O Don't search. | will choose the driver to install

Chooge this option to select the device driver from a list. ‘Windows does not guarantee that
the driver you chooze will be the best match for pour hardware.

[ < Back ][ Mext > ][ Cancel

Figure 2.3

If Windows XP is configured to warn when unsigned (non WHQL certified) drivers are about to be installed, the
message dialogue shown in Figure 2.4 will be displayed unless installing a Microsoft WHQL certified driver. Click on
"Continue Anyway" to continue with the installation. If Windows XP is configured to ignore file signature warnings, no
message will appear.
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The screen shown in Figure 2.5 will be displayed as Windows XP copies the required driver files.

Hardware Installation

L) 'j The zoftware you are inztalling for this hardware;
-

LISE Serial Corvverter

haz not pazzed Windows Logo testing to verify its compatibility with
thiz werzion of Windows, [Tell me why this testing iz impartant)

Continuing your ingtallation of this software may impair
or destabilize the correct operation of your system
either immediately or in the future. Microzoft strongly
recommends that you stop this installation now and
contact the hardware vendor for zoftware that has
passed Windows Logo testing.

[ Continue Anyway ] | STOF Installation |

Figure 2.4

Found New Hardware Wizard
Pleage wait while the wizard installs the software__.

% USE Serial Converter

=, 7

ftd 2. dll

To C:AWINDOWShepstern 32

(FEeswRRRR )
Figure 2.5

Windows should then display a message indicating that the installation was successful (Figure 2.6). Click "Finish" to
complete the installation for the first port of the device.
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The Found New Hardware Wizard will launch automatically to install the COM port emulation drivers. As above,
select "No, not this time" From the options and click "Next" to proceed with the installation (Figure 2.7).

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finizhed installing the software for:

g USE Serial Corverter

Click Finish to close the wizard.

Figure 2.6

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard
Windows will search for current and updated software by

looking on your computer, on the hardware installation CO, or on
the Windows Update ‘Web site [with pour permission).

Online privacy information

Can Windows connect to \Windows Update to search for
software?

(O Yes, this time only
(O)Wes. now and every time | connect a device

(O]

Click Next to continue.

[ Mext > ][ Cancel

Figure 2.7

Select "Install from a list or specific location (Advanced)" as shown in Figure 2.8 below and then click "Next".
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Select "Search for the best driver in these locations" and enter the file path in the combo box ("C:\CDM 2.02.04" in
figure 2.9 below) or browse to it by clicking the browse button. Once the file path has been entered in the box, click
next to proceed.

Found New Hardware Wizard

Thiz wizard helps you install saftware for:

USE Senial Port

f'\‘-) If your hardware came with an installation CD
2 or Hoppy disk. insert it now.

What do pou want the wizard to do?

() Install the software automatically (Fecommended)

@nstall fom a st or specific lneation [Advancedt

Click Next to continue.

[ < Back H Hest > ]I Cancel

Figure 2.8

Found New Hardware Wizard
Pleaze choose your search and installation options.

Uze the check boxes below ta limit or expand the default zearch, which includes local
paths and removable media. The best diver found will be installed.

[] Search removable media (floppy, CO-ROM...)

Include this location in the search:
[c:7CDM 20204 v

(O Don't search. | will choose the driver ta install

Choosze this option to select the device driver from a list. ‘Windows does not guarantee that
the driver you choose will be the best match for pour hardware.

[ < Back ” Mest > ][ Cancel

Figure 2.9

If Windows XP is configured to warn when unsigned (non WHQL certified) drivers are about to be installed, the
message dialogue shown in Figure 2.10 will be displayed unless installing a Microsoft WHQL certified driver. Click
on "Continue Anyway" to continue with the installation. If Windows XP is configured to ignore file sighature warnings,
no message will appear.
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The screen shown in Figure 2.11 will be displayed as Windows XP copies the required driver files.

Hardware Installation

L] E The zoftware you are inztalling for this hardware:
L
USE Serial Part

haz not passed Windows Logo testing to verify its compatibility with
this version of Windows. [Tell me why this testing is important)

Continuing your installation of this software may impair
or destabilize the comrect operation of your system
either inmediately or in the future. Microsoft strongly
recommends that you stop thig inzstallation now and
contact the hardware vendor for software that has
paszzed Windows Logo testing.

[ Cortinue Srgwmay ] | STOP Installation |

Figure 2.10

Found New Hardware Wizard
Please wait while the wizard installs the software...

(3 UUSE Serial Port

7 -
ftseri2.dll
To C:AWINDOWShepstern 32
[ 1l
Figure 2.11

Windows should then display a message indicating that the installation was successful (Figure 2.12). Click "Finish"
to complete the installation for the first port of the device.

The procedure for installing the second port is identical to that for installing the first port from the first screen of the

Found New Hardware Wizard for the USB Serial Port device. If the driver is Microsoft WHQL certified, this is done
automatically.
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Open the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and click "Device
Manger") and select "View > Devices by Connection”, the device appears as a "USB Serial Converter" with an
additional COM port with the label "USB Serial Port" (Figure 2.13).

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finizhed installing the software for:

/g UUSE Serial Port
i

Click Finish to close the wizard.

Figure 2.12

Device Manaper

Fle Action View Help

& 2 A
'd ACPI Fixed Feature Button A
W Genuine Intel(R) CPU 2160 @ 1.80GHz
# Genuine Intel(R) CPU 2160 @ 1.80GHz
=l i PCIbus

# :é InkeliR) 948GZ Express Chipset Family
1 Inkel(R) 82501 PCI Bridge - 244E
Inkel(R) §2801G (ICHT Family) SMBus Controller - 27DA
+ 6 Intel(R) 528016 (ICH7 Family) USE Universal Host Contraller - 27C8
Inkel(R) §2801G (ICHT Family) USE Universal Host Contraller - 27C9
=182 1SR Bookbus
= |JSB Serial Canverter
5 USE Serial Port (COM3)
5 FMFT Uo6 Universal Host Controller - 27CA
Inkel(R) 826016 (ICH7 Family) USE Universal Host Contraller - 27CE
Inkel(R) 828016 (ICH7 Family) USB2 Enhanced Host Contraller - 27CC
_,3 Intel(R) 52501GE/GR (ICH? Family) LPC Interface Contraller - 2765
%) Intel(R) 62801 GE/GR/GH (ICHT Family) Serial ATA Storage Controller - 27C0
¢ Intel(R) 946GZ{PL{GL PCI Express Rook Fort - 2971
¢ Intel(R) S46GZ{PLIGL Processor ko 1[0 Controller - 2570
= } Micrasoft LLAA Bus Driver for High Definition Audia
¢ Motherboard resources ¥

4
4
4
4

Figure 2.13

Device Manager

Fle  Action iew Help
g 2

= % PCIbus ~
+- @ Intel(R) 94662 Express Chipset Family
+- o IntelfR) 82801 PCI Bridge - 244E
by Intel(R) 828016 (ICH7 Family) SMBus Controller - 27DA
Inkel(R) 528016 (ICH? Famnily) USE Universal Host Contraller - 27C5
Inkel(R) 828015 (ICH? Family) USE Universal Host Controller - 2709
=] Inkel(R) 828016 (ICH? Family) USE Universal Host Controller - 27CA
-6 USB
B USE Composite Device
=l 8 UISE Serial Converter &
5 Us8 serial Part (COM3)
= €% USB Serial Converter B
5 use serial Port (COM4)

+ =
+ g Intel{R) 52801 (ICH7 Family) USEZ Enhanced Host Controller - 27CC
- | Inkel(R) 82801GB/GR. (ICHT Family) LPC Interface Controller - 2768
-2 Intel(R) 82801GB/GRIGH (1CH? Famiy) Serial ATA Storage Contraller - 270
' IntelfR) S46G2/PLIGL PCI Express Rook Port - 2571
j Inkel(R) 946GZ/PLIGL Processor ko 1) Controller - 2970
+- 1 Microsoft LR Bus Driver For High Defirition Audio
4 Matherboard resources v

Figure 2.14
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2. Installing Using DPInst

In the case of a Microsoft WHQL certified driver package, it is possible to preinstall the driver package using the
Microsoft Driver Install Frameworks (DIFX) tools. The simplest tool provided is the Driver Package Installer (DPInst).
When placed in the same directory as the INF files for the driver package, simply run DPInst.exe and the certified
driver package will be installed on the machine.

The current driver package supports 32bit and 64bit systems through common INF files. DPInst has separate
executables for 32bit and 64bit installation. This means that if a single solution is desired for 32bit and 64bit systems,
the developer must be able to detect which version of DPInst is required for the system the driver is being installed
on.

For more information on DPInst, see the FTDI Windows Driver Installation application note.

3. Installing From Windows Update

If a certified driver is available for the target operating system, it is possible to install the driver from the
Windows Update web site.

Directions to install the driver from Windows Update are very similar to those outlined in 2.1 Installing Via The New
Hardware Wizard, except that the “Yes, this time only” or “Yes, now and every time | connect a device” option
should be selected on the first screen of the wizard when asked if Windows Update should be checked for a driver.
If the wizard finds a matching driver on Windows Update, the driver will be automatically downloaded and installed
for the device.

Please note:
1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat this
installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or appropriate
versions from FTDI Web site www.ftdichip.com/Drivers/VCP.htm .
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Uninstalling Instruction

Consequently, a new method for uninstalling has to be used. Devices can be removed using the Device Manager by
simply right clicking on the device and selecting "Uninstall". This will delete the associated registry entries for that
device only.

Under Windows XP, driver files and OEM INF and PNF files must be removed manually or by using a custom
application. OEM INF and PNF files are located in the Windows\Inf directory and can be identified by searching for a
VID and PID string matching the device installed e.g. VID_0403&PID_6001. Once the matching OEM INF files are
found (e.g. oem10.inf for FTDIBUS.INF and oem11.inf for FTDIPORT.INF), the corresponding PNF files must also
be removed (e.g. oem10.pnf and oem11.pnf). Driver files are located in the Windows\System32 and
Windows\System32\Drivers directories.

Some points to note about this uninstallation method:

If the VCP driver has been installed, the COM port driver should be removed before the bus driver. If the bus is
removed first, the COM port will no longer appear in the Device Manager.

If the driver files are deleted while other installed devices still require them those devices will not work correctly. This
can be fixed by right clicking the device and selecting "Reinstall Driver" which will replace the missing files.

If a device to be uninstalled is not connected to the PC, the device can still be removed by setting the device
manager to show phantom devices. This can also allow a virtual COM port to be uninstalled if the bus layer has
been removed first. Instructions on how to display phantom devices are given in the Advanced Driver Options
application note.
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Troubleshooting
1. Windows XP cannot find Drivers for My Device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in the INF
files for the driver. The VID and PID programmed into the device EEPROM may be found by using the USB View
utility from the FTDI web site. These can then be checked against the VID and PID entries in the driver INF files. If
they do not match, that driver cannot be installed for that device without either reprogramming the device EEPROM
or modifying the list of VID and PID numbers in the INF files.

Please note that only your own company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use by your
company should be used in the EEPROM and INF/INI files.

End customers should obtain modified drivers from the OEM of the device, and not necessarily edit the files
themselves.

2. Windows XP Forces a Reboot after Installing a Device

This problem can occur if an application is accessing a file while the New Hardware Wizard is trying to copy it. This
usually occurs with the FTD2XX.DLL file. Selecting not to restart the computer then unplugging and re-plug the
device may allow the device to function properly without restarting. Restarting the machine will allow the device to
work correctly.

3. Driver Installation Fails and Windows XP Gives Error Code 10

Windows error code 10 indicates a hardware error or failed driver installation. This error may appear if a device has
insufficient power to operate correctly (e.g. plugged into a bus powered hub with other devices), or may indicate a
more serious hardware problem. Also, it may be indicative of USB root hub drivers being incorrectly installed.

Please refer to the example schematics on the FTDI web site for standard device configurations. If the error persists,
please contact the FTDI support department.
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4. Windows XP Displays An Error And Then Terminates Installation

If the following screen is displayed with this message, Windows XP has been configured to block the
installation of any drivers that are not WHQL certified.

Hardware Installation

Q The software you are installing for thiz hardware:
USE Seral Converter

has not passed Windows Logo testing to werifi its compatibility
wath this wersion of Windows, [Tell me why this testing i important]

T his hardsweare will not be installed. Contact powr system
adrministrator.

Figure 4.1

Two options are available to successfully install the device. Either a certified version of the driver can be installed
(if available) or the driver signing options can be changed to either warn or ignore to allow the installation to
complete.

To change the current driver signing setting, go to "Control Panel\System", click on the "Hardware" tab and then
click "Driver Signing". The desired signing option may then be selected.
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Windows VISTA (Win 7, 8, 8.1, 10) Installation Guide

Connect the device to a spare USB port on your PC.

If there is an available Internet connection, Windows VISTA (Win 7, 8, 8.1, 10) will silently connect to the Windows
Update website and install any suitable driver it finds for the device in preference to the driver manually selected. If
no suitable driver is automatically found then the following procedure should be followed.

I T Found New Herchware

=

Windows needs to install driver software for your TTL232R
Tester

@ Locate and install driver software (recommended)

Windows will guide you through the process of installing driver software
for your device.

% Ask me again later
Windows will ask again the next time you plug in your device or log on,

® Don't show this message again for this device
Your device will not function until you install driver software.

When locate and install driver software (recommended)" is selected the following screen will appear. Note: the text
“TTL Tester” is replaced with the description of the customer hardware.

o
Cj [l Found New Hardware - TTL232R Tester
Insert the disc that came with your TTL232R Tester

If you have the disc that came with your device, insert it now. Windows will automatically
search the disc for driver software.

< Idon't have the disc. Show me other options.
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Select “I don't have the disk. Show me other options” The next screen will appear.

@ | Found New Hardware - TTL232R Tester

Windows couldn’t find driver software for your device

= Check for a solution
Windows will check to see if there are steps you can take to get your device
working.

= Browse my computer for driver software (advanced)
Locate and install driver software manually.

Select “Browse my computer for driver software (advanced)”. The next screen will appear.

€5 L Found New Hordware - TTL232R Tester
Browse for driver software on your computer

Search for driver software in this location:

[C:\Users)| Desktop\CDM 2.00.00 (Certified)

[¥] Include subfolders

Browse to the folder where the CDM driver has been stored (when uncompressed) and press “Next”

The example shown above uses a folder on the desktop.
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The next screen will appear.

=) [ FoundNew Hardware - TTL232R Tester

Installing driver software...

This screen will automatically complete and then change to the one below:

FK\:) [ Found Mew Hardware - USE Serial Converter

The software for this device has been successfully installed
Windows has finished installing the driver software for this device:

USB Serial Converter

The bus layer of the driver is now installed.

After the driver is installed it is important to determine which COM port has been assigned to the device for
configuring the application that will use the device.
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Open the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and click "Device
Manager") and select "View > Devices by Connection”, the device appears as a" USB Serial Converter" with an
additional COM port with the label "USB Serial Port".

-+ Device Manager =il )
File Action View Help
Ll dllall 7 Boall.c
w-{& Computer

+-— Disk drives

1 & Display adapters

L} DVD/CD-ROM drives

= Floppy disk drives

&3 Floppy drive controllers

'.’f;;, Human Interface Devices

g IDE ATA/ATAPI controllers

§ IEEE1394 Bus host controllers

= Keyboards

ﬂ Mice and other pointing devices

& Monitors

¥ Network adapters

K Portable Devices

=73 Ports (COM & LPT)

| "3 Communications Port (COML)
Y2 Printer Port (LPT1)
"3 USB Serial Port (COM3)

o) B Processors

--4% Sound, video and game controllers
%, High Definition Audio Device

3 < Storage controllers

B [ o O o o O ool O . A ) . I o R

+-1& System devices
- Universal Serial Bus controllers

This screen shows the device connected to COM3.

Please note:
1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat this
installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or appropriate
versions from FTDI Web site www.ftdichip.com/Drivers/VCP.htm .
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Uninstalling Instruction

With the release of Microsoft Windows Vista, the FTDI uninstaller has been rendered unusable due to Windows
Resource Protection preventing the executable from deleting driver files and associated registry values. Vista will
only allow the system itself to modify files and registry values in these locations.

Consequently, a new method for uninstalling is required. Devices can be removed using the Device
Manager by simply right clicking on the mouse and selecting "Uninstall". This will delete the associated
registry entries for that device only. Vista provides an automatic method to delete driver files via a check
box to "Delete the driver software for this device" on the uninstall dialog box.

Confirm Device Uninstall

LISE Senal Converer

.

Waming: You are about to uninstall this device from your system.

| ok || Concel

Windows 2000, XP and Server 2003 do not have this check box, so driver files and OEM INF and PNF files
must be removed manually or by using a custom application.

Some points to note about the new uninstallation method:

If the VCP driver has been installed, the COM port driver should be uninstalled before the bus driver. If the bus is
removed first, the COM port will no longer appear in the Device Manager.

If the files are deleted while other installed devices still require them those devices will not work correctly. This can
be fixed by right clicking the device and selecting "Reinstall Driver" which will replace the missing files.

If a device to be uninstalled is not connected to the PC, the device can still be removed by setting the device

manager to show phantom devices. This also allows a virtual COM port to be uninstalled if the bus layer has been
removed first.
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Troubleshooting

1. Windows VISTA (Win 7, 8, 8.1, 10) can not find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in the INF
files for the driver. The VID and PID programmed into the device EEPROM may be found by using the USB View
utility from the FTDI web site. These can then be checked against the VID and PID entries in the driver INF files. If
they do not match, that driver cannot be installed for that device without either reprogramming the device EEPROM
or modifying the list of VID and PID numbers in the INF files. Please note that only your own company VID and PID
or FTDI's VID (0x0403) and FTDI PID issued for use by the customer should be used in the EEPROM and INF files.

End customers should obtain modified drivers from the OEM of the device, and not necessarily edit the files
themselves.

2. Devices not shown in Device Manager for uninstalling

Devices that have been installed on a system but are not currently available are referred to as "phantom devices".
These devices are not usually displayed in the device manager, but can be made to be displayed as though they are
attached. This allows device properties to be changed or devices to be uninstalled via Device Manger even though
the device is not physically connected to the PC.

To display phantom devices in Device Manager, a new system variable is required. Open "Control Panel >
System" then select the "Advanced" tab and click "Environment Variables". In the System Variables section
(NOT THE USER VARIABLES SECTION), click "New..." to display the following window:

Edit System Variable =™
Variable name: DevMgr_Show_MonPresent_Devices
Variable value: 1]
[ OK | | Cancel |

Create a new System Variable called "DevMgr_Show_NonPresent_Devices" and set the value to 1, then
click OK.

Open the Device Manager ("Control Panel > System" then select the "Hardware" tab and click "Device

Manager...", or "Control Panel > Device Manger" in Vista) and select "View > Show Hidden Devices".
Device Manager will then show all hidden and phantom devices available on that PC as shaded.
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3. Windows Vista (Win 7, 8, 8.1, 10) shows a warning that the driver is not certified

If the driver is not certified then a pop up window such as shown below will be displayed.

fg} Windows Security

@ Windows can't verify the publisher of this driver software

=» Don't install this driver software
¥ou should check your manufacturer's website For updated driver soffware For wour
device,

=% Install this driver software anyway
Cnly inskall driver software obtained from wour manufacturer's website or disc.
Unsigned software fram ather sources may harm your computer or skeal infarmation.

:l See details

If you are certain of the source of the driver the warning can be ignored and you can continue installation
by selecting “Install this driver software anyway”.

4. Driver will not install on VISTA x64

VISTA x64 OS will only allow certified drivers to be installed. The certified driver supplied by FTDI will work with VID
0403 and PID 6001 for FT232 devices.

If you have a product where the manufacture has customized the driver but has not recertified it, then the driver will
not load. You should contact your vendor to determine if they will support VISTA x64.
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MAC OS X Installation Guide

Download the driver from the VCP Drivers section of the FTDI web site and save it to the hard disk. The driver is
now available in disk image (.dmg) format. Run the installer by double clicking on the FTDIUSBSerialDriver.dmg
icon.

rﬁ en Install FTDIUSBSerialDriver Kernel Extension

‘- e | Welcome to the Mac 05 X Installation Program. You will be
© Introduction guided through the steps necessary to install this software.

® Read Me

Welcome to the FTDIUSBSerialDriver Kernel Extension Installer

[ ] Sele& Destination
® Installation Type

® Installing

® Finish Up y

Go Back | Continue |

Click Continue to proceed with the installation and follow the instructions on screen.

When the installation is complete, reboot the computer.

rB e o Install FTDIUSBSerialDriver Kernel Extension

O Introduction
@ Read Me

Install Software

© Select Destination

© Installation Type
© Installing The software was successfully installed

O Finish Up w

Click Restart to finish installing the software.

GoBack ) (SRestarts)

46


http://www.ftdichip.com/

When the computer has rebooted, plug in the device. If the device is installed properly, you will see entries in the
/dev directory:

/dev/cu.usbserial-xxxxxxxx
/dev/tty.usbserial-xxxxxxxx

Where xxxxxxxx is either the device's serial number or, for unserialized devices, a location string that depends on
which USB port your device is connected to. The Terminal application can be launched by selecting Go >
Applications > Utilities > Terminal. Type the following lines in the Terminal window to produce the file list:

cd /dev
Is-|

If you run the application System Preferences and select Network (Go > Applications > System Preferences >
Network), you should see the text "New Port Detected".

New Port Detected

i w A new network port has been detected:
usbserial-1B22

Please verify that it is configured correctly, then

press Apply Now to activate it

Click OK and select Network Port Configurations from the show list. The new port can be enabled from this screen
by checking the on box and clicking Apply Now.

r -
88eo o
¢ [ &
Show All D;spla;rs Sound  MNetwork Startup Disk
Location: | Automatic 9
Show: Network Port Configurations |'3‘!
Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.
On  Port ConFiQuratiDns |
B usbserial-1B22 ——
E Internal Modem { New...
E Built-in Ethernet { Edit ‘J
( Delete.. )
( Duplicate 3
@
Sk I :
[IF] " Click the lock to prevent further changes. [ Assistme... ) [ Apply Now )
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At this point, it is possible to exit Network and use the device as a COM port. If you wish to set the device up a
modem for an Internet connection, select the new port from the Show list to display the window below.

.

'_6 80 Metwork (=]

= & @

Show all Displays Sound Network Startup Disk

L

Location: = Automatic [

ir
L LR

“

Show: ushserial-1822 f

[ pPP | TCP/IP  Proxies = Modem |

Service Provider: (Optional)

Account Name:

Password:

Telephone Number:

Alternate Number: (Optional)

] Save password
Checking tnis box allows all users of this computer to
access this Internet account without entering a password.

li PPP Options... ) ( Dial Now... \,'I
@
o e
'] Click the lock to prevent further changes. [ Assistme... | Apply Now

Entries for this screen are specific to the Internet account for each user. If you do not know the required details,
contact your Internet service provide

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat this
installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or appropriate
versions from FTDI Web site www.ftdichip.com/Drivers/VCP.htm .
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Uninstalling instruction

To remove the drivers from Mac OS X, the user must be logged on as root. Root is a reserved username that has
the privileges required to access all files.

Start a Terminal session (Go > Applications > Utilities > Terminal) and enter the following commands at the
command prompt:

cd /System/Library/Extensions

rm -r FTDIUSBSerialDriver.kext

cd /Library/Receipts

rm -r FTDIUSBSerialDriver.kext

The driver will then be removed from the system.

To remove the port from the system, run the application System Preferences and select Network. Selecting Network
Port Configurations from the Show menu will display the port as greyed out. Select the uninstalled port and click
Delete. Confirm the deletion to remove the port.

r_ﬁ an Network e

« Wy O

Show All Displays Sound Network Startup Disk

Location: Automatic f

Show: Metwork Port Co_nfigurations s !

Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.

0On | Port Configurations

ushserial-1B22 —————————
( Mew )

E Internal Modem —
M  Built-in Ethernet —ri—
) S
{ Delete... )
Duplicate
@
d o —
'] Click the lock to prevent further changes. [ Assistme... Apply Now
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Troubleshooting

1. How do | know what my device ID is?

Launch the System Profiler utility, or Apple System Profiler for earlier versions of OS X. This can be accessed by
going to the Finder and selecting Applications from the Go menu, then open the Utilities folder.
Select USB under Hardware in the pane to the left and then select the appropriate device from the USB Device Tree.
In the screen shot below (from OS 10.3), the device has a device ID given by:

Vendor Name: FTDI

Product ID: 24577 ($6001)

A Vendor Name of FTDI is equivalent to a Vendor ID of 1027 ($0403).

rﬂ a8 System Profile
Andy's eMac 10/01/2005 08:37
[Contents ' USE Device Tree
¥ Hardware USE Bus
Memory ¥ USE Bus
PCIJAGP Cards wHub in Apple Extended USB Keyboard
ATA USE <-> Serial
SCsI Apple Optical USE Mouse
USE Apple Exterded USB Keyboard
FireWire USE Bus
AirPort Card USBE High-5peed Bus
Modems
¥ Software
Applicatiors -
Exteénsions USB <-> Serial:
Network
Logs ~ Vendor Name:  FTDI
Speed: Up to 12 Mb/sec
Product ID: 24577 (36001)

Bus Power (mA): 100

4

If the device does not work after installing the driver, it is likely to be because the PID is not supported by the driver.
If this is the case, contact FTDI Support with the PID that needs to be added to the driver. If the VID is not 0x0403, it
is likely that the device is not an FTDI device and we cannot support it.
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2. The device does not appear in the /dev directory or the text "New Port
Detected" is not displayed in System Preferences-Network

FTDI USBSeria Driver does not support your device ID (VID and PID). Disable the EEPROM so that the
device reverts to its default device ID, then replug. To get support for your device ID built into FTDI
USBSerial Driver, contact FTDI quoting your device ID and a description of your device.

3. The device cannot be accessed even though the device ID is Supported
in FTDI USBSerial Driver

An ownership or permissions problem is preventing the system from making the device accessible. Check
that the driver is owned by root and wheel. The most common symptom is the group for FTDI USBSerial
Driver is not wheel. To change the group, login as root and perform the following script in a Terminal
window (Go > Applications > Utilities > Terminal):

cd /system/library/extensions

chgrp -R wheel FTDIUSBSerialDriver.kext

Reboot for the change to take effect.
4. How do | open a Terminal window?

A Terminal window can be started by selecting Go > Applications > Utilities > Terminal .The terminal
window is equivalent to a DOS prompt in Windows.
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Regulatory Compliance

Disclaimer

Information in this document is subject to change without notice. The manufacturer does not make any representations or
warranties (implied or otherwise) regarding the accuracy and completeness of this document and shall in no event be liable for
any loss of profit or any other commercial damage, including but not limited to special, incidental, consequential, or other
damages.

No part of this document may be reproduced or transmitted in any form by any means, electronic or mechanical, including
photocopying, recording or information recording and retrieval systems without the express written permission of the
manufacturer.

All brand names and product names used in this document are trademarks, or registered trademarks of their respective holders.

CE Certification
This equipment complies with the requirements relating to electromagnetic compatibility.
It has been manufactured under the scope of RoHS compliance.

FCC Compliance Statement

This equipment generates and uses radio frequency and may cause interference to radio and television reception if not installed
and used properly. This equipment has been tested and found to comply with the limits of a Class B digital device, pursuant to
part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a
residential installation.

You are cautioned that changes or modification not expressly approved by the party responsible for compliance could void your
authority to operate the equipment.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:

(1) This device may not cause harmful interference, and

(2) This device must accept any interference received, including interference that may cause undesired operation

E WEEE (Waste of Electrical and Electronic Equipment),
Recycling of Electronic Products

In 2006 the European Union introduced regulations (WEEE) for the collection and recycling of all waste electrical and electronic
equipment. It is no longer allowable to simply throw away electrical and electronic equipment. Instead, these products must
enter the recycling process.

Each individual EU member state has implemented the WEEE regulations into national law in slightly different ways. Please
follow your national law when you want to dispose or any electrical or electronic products. More details can be obtained from
your national WEEE recycling agency.
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